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1.0 - Getting Started 

The purpose of this document is to take the user through some of the steps required to set up the 

program and get to the stage where they can create a plan and survey.  

This document assumes that Well Seeker Pro has already been installed (see Manual for Install 

guide) and this is the first time the program has been opened. 

 

1.1 - Display 
When you first open Well Seeker, the screen will be configured as below. 

 

 

 

 

 

 

 

The layout of the screen can be adjusted by going to View - Toolbars and Docking Windows 

 

 

 

The user can then choose what to display. For the rest of this document, the Output and Properties 

windows will be unselected. 
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2.0 - Creating a new database 
The database is the .mdb file that Well Seeker Pro is directed to access information from. It is vitally 

important that the user is aware of the location of and backs up their database file regularly to 

another storage device. If this is done correctly then the user will always have a backup in the event 

of an unforeseen event such as a computer hard drive failure, that would have otherwise resulted in 

the loss of the database file and all the input data. 

The first thing to do when creating a new database is to select where you want to store the database 

on your computer. Ideally you want to put it somewhere where it will not need to be moved.  

 Create a folder somewhere in the C: drive and name it appropriately. 

 Go to File > Create New Database 

 The box below will appear 

 

 Navigate to the desired location where you will save the new database and enter your 

database name in the File Name: box and click Save 

 The new database will now have been created as a .mdb file at your chosen destination 

 Go to File > Select Database, browse to and select the database you have just created 
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You have now created a new database and your screen should look like above, note that the 

database you have selected will be displayed at the bottom of the screen as highlighted by the red 

box. 

You can navigate to the file location of your database by opening the Help menu and selecting Open 

database location. To backup your database file open the File menu and select Backup Database. 

This will open a dialog box where you can choose a suitable location and name for the backup. 

 

3.0 - Switching between Databases 
It is very straightforward to switch between databases, making it easy to maintain multiple 

databases depending on the user's needs. 

 Go to File - Select Database 

 Go to the location of the database you would like to use 

 Select the database and hit open 

 The new database will now be selected and can be used. 
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4.0 - Creating a new Well 
The following section details the steps to follow in order to create a new well. 

4.1 - Unit Selection 
The first thing to do is to make sure that you have the correct units selected. 

 Click on the Units icon located in the bar at the top of the screen or open the Tools menu 

and select Unit Sets. 

 
 This will open the Unit Sets dialog box 

 

 Well Seeker comes as standard with 3 unit sets (API, SI & US), which are all editable 

 There is also the option to create a new unit set using the Create new button. To edit a new 

unit set, click the Edit button. This will allow the user to access the unit drop down menus to 

change the parameters to the desired units. 
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1. Depth: Current units for measured depth and TVD. Options are Feet, US Feet and Meters. 

2. Local: Current units for NS, EW and centre to centre distances. Options are Feet, US Feet and 

Meters. 

3. Geographic: Defines what units the map co-ordinates are displayed in. Options are CRS 

Default (the unit set defined by the selected CRS), Feet, US Feet and Meters. 

4. Diameter: This defines the units used to display Casing OD and ID as well as hole size. 

Options are mm and inches.  

5. Dogleg: The current units DLS, BR and TR are displayed in. Options are Deg/100ft (or 30m), 

Deg/30ft (or 10m) or user defined. If user defined is selected, the parameter column 

becomes active and the units value becomes degrees per unit length based on the 

parameter entered.  

6. Survey Calculation Method: This defines which calculation method is used for calculating 

survey parameters throughout Well Seeker PRO. Options are Minimum Curvature, Radius of 

Curvature, Tangential and Balanced Tangential. It should be noted that if a method other 

than minimum curvature is selected the Well Planning tools will not work.  

7. Flow Rate: Current units for flow rate. User can choose between LPM and GPM.  

8. Pressure: Current units for Pressure. User can choose between Bar and psi 

9. Volume: Current units for Volume. User can choose between BBLS and m3 

10. Mud: Current units for Mud Weight. User can choose between PPG, SG, psi/ft3 and lbs/ft3 

11. Weight: Current units for Weight. User can choose between klbs and Tons 

12. Torque: Current units for Torque. User can choose between kftlb and kNm 

13. Temperature: Current units for Temperature. User can choose between degC and degF. 

14. Cost: Current units for Cost. User can choose between $, EUR and GBP. 

15. Jets: Current units for Jet size. User can choose between in2 and mm2. 

 

 Whatever is selected here will be applied to the whole database. It can be changed at any 

point, but the units are set for the whole database and not individual operators or wells. 

 Special care must be taken at this point because the survey calculation method affects the 

way the plans and surveys are generated. It is very unlikely that anything other than 

Minimum Curvature will ever be selected.  
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4.2 - New Instant Plan / Survey 
It is possible to create an instant plan or survey in Well Seeker. This can allow the user quick access 

to the planning tools without having to go through the process of filling in all the different levels of 

data to get there. For this kind of requirement, surface locations, elevations etc are of no concern 

and Well Seeker uses generic values at all the levels. 

To create an instant plan or survey, right click on the database and select New Instant Plan or New 

Instant Survey. 

 

 

 

 

 

 

 

 

 

 

4.3 - New Operator 
 Right click on the database and select Insert New Operator. 

 The Operator Properties box will now appear 

 

 

 

 

 

 

 The Operator level is where the user sets up the company anti-collision policy, and it is very 

important to ensure this is done correctly 

 This is also the level where the primary and secondary logos are added. These logos are then 

available to be included on generated reports 
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4.4 - New Field 
 

 Right click on the Operator and select Insert New Field 

 The Field Properties box will now appear 

 

 

 

 

 

 

 

The following data is input at this level: 

 Mapping Grid or Coordinate Reference System (CRS). If the required CRS is not available a 

new one can be added (see the Adding a new Coordinate Reference System section) 

 Azimuth North Reference: Grid or True 

 Local Coordinate system: 

o Well Centred - Local coordinates for all plans & surveys will be referenced to the 

well location making all local coordinates 0.00N & 0.00E at surface. 

o Facility Centred - Local coordinates for all plans & Surveys will be referenced to the 

facility location meaning local coordinates at surface will vary between wells. 

 

 Apply Scale Factor: If this option is selected, the scale factor defined in the CRS will be used 

to calculate map co-ordinates from local co-ordinates. This is the ratio between measured 

distances on the map compared to measured distances on the ground as a result of 

distortion of linear scale associated with mapping a spherical surface (the earth) onto a 

plane. Note that this option does not affect the local coordinates, only the map coordinates 

(Northing and Easting’s). 

 Show Map: This extends the existing dialog to include a Google Maps section. This will show 

the location of the positional data entered and can be toggled between map and satellite 

view using the Satellite checkbox. The map can also be zoomed in and out using the – and + 

buttons. This map location will only be accurate if the CRS selected uses WGS 84, as this is 

what Google Maps utilises. 
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 Show Field Ref Point on Report: When selected, the field reference point coordinates will 

be included in the Field data box of any report generated. Default is off. 

 Field Reference Point: This is the reference location used for the field.  

 Input: Select the coordinates used to enter the Field Reference Point. Either Latitude & 

Longitude or Grid Easting & Northing. 

 Grid Convergence is not editable as it is based on the CRS selected and the Field Reference 

Point entered. 

 System Vertical Datum: This is the datum which all TVDs below field level will be referenced 

to. This is usually either mean sea level “MSL”, lowest astronomical tide “LAT” or some other 

user specified value. If a value other than MSL is selected from the combo box, the elevation 

above or below MSL must be entered. A positive value indicates that the datum is above 

mean sea level and a negative value indicates it is below it. 

Once the required inputs have been completed, click Apply then Close on the bottom right of the 

window. To access the Field Properties again at any time, right click at the Field level and select 

properties 
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4.5 - New Facility 
 

 Right click on the Field and select Insert New Facility 

 The Facility Properties box will now appear 

 

 

 

 

 

 

 

The following data is input at this level: 

 A slot template can be created by Clicking on the Templates button (see Creating a Slot 

Template section for more detailed instructions) 

 Lease /Hard Lines: The user can select to have lease / hard lines show at all levels within the 

Targets dialog. On will pre-select the lease / hard lines to be displayed from Field to Actual / 

Plan levels. Off will pre-select the lease / hard lines to be displayed from Field to Facility 

level only. 

 Show Map: This extends the existing dialog to include a Google Maps section. This will show 

the location of the positional data entered and can be toggled between map and satellite 

view using the Satellite checkbox. The map can also be zoomed in and out using the – and + 

buttons. This map location will only be accurate if the CRS selected uses WGS 84, as this is 

what Google Maps utilises. 

 Facility Reference Point: This is the reference location used for the facility. For an offshore 

platform, this is usually platform centre and for an onshore facility, this is usually the centre 

of the site. This location will provide the Local Coordinates of 0.00N & 0.00E if Facility 

Centred Local Coordinate System was selected in the level above 

 Input: Facility Reference Point Select the units used to enter the Facility Reference Point. 

Either Latitude & Longitude or Grid Easting & Northing. 

 Grid Convergence is not editable as it is based on the CRS selected and the Facility 

Reference Point entered. 

 Facility Location Uncertainty: The uncertainty of the facility location to 1 sigma. If unknown, 

leave as 0. 

Once the required inputs have been completed, click Apply then Close on the bottom right of the 

window. To access the Facility Properties again at any time, right click at the Facility level and 

select properties.  
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4.6 - New Well 
 Right click on the Facility and select Insert New Well 

 The Well Properties box will now appear 

 

 

 

 

 

 

 

 

 

The following data is input at this level: 

 Location Uncertainty: The uncertainty of the Wellhead location to 1 sigma. If unknown, 

leave as 0. 

 Wellhead Location:  

o Slot: This allows the user to select any of the slots created in the template editor and 

the location will be automatically input based on this selection 

o Offset from Facility: This is the local Coordinates which allows the user to enter the 

distances at surface between the facility location and the wellhead location 

o Map: Input location as Grid Easting & Northing 

o Geographic: Input location as Latitude & Longitude 

 Depth Reference: Allows the user to input the relevant elevations. Default is for an onshore 

well with Ground Level to MSL, however If “offshore” is selected, the user can enter the well 

head elevation above MSL. If “subsea” is selected, the elevation below MSL can be entered. 

This is the distance between the top of the well head and MSL. By checking the Default box, 

the selected elevation will be automatically assigned to any new plans or surveys created. 

 Show Map: This extends the existing dialog to include a Google Maps section. This will show 

the location of the positional data entered and can be toggled between map and satellite 

view using the Satellite checkbox. The map can also be zoomed in and out using the – and + 

buttons. This map location will only be accurate if the CRS selected uses WGS 84, as this is 

what Google Maps utilises. 

Once the required inputs have been completed, click Apply then Close on the bottom right of the 

window. To access the Well Properties again at any time, right click at the well level and select 

properties.  
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5.0 - Creating a new Well Plan 
 Right click on the Well and select Insert Planned Well 

 The Plan Properties box will now appear 

 

 

 

 

 

 

 

 

 

The following data is input at this level: 

 Set as Principal Plan: Selecting a plan as the principal sets it apart from the other plans as 

the most important one, and it also tells Well Seeker to use it as the reference plan when 

the user is in a survey file under the same well. When inputting surveys, Well Seeker will 

display details telling the user how far away, Toolface, X & Y offset etc the survey is from the 

principal plan. 

 Tolerance Circles: Tolerance circles are for visual reference only. The radius of the inner and 

outer tolerance circles can be added here. These can be displayed in a plan or spider plot by 

selecting their inclusion in the chart properties dialog. The default colours for the inner and 

outer tolerance circles can be adjust in the Plots>Chart Defaults menu. 

 Vertical Section: The VS azimuth and the local origin of the VS 

 Depth Reference: This will be the selected default (from Well Level), but can be changed by 

selecting options from the drop down list 

 Magnetics: Magnetic data can be generated here by selecting the model and the date. If the 

relevant model is not available, user defined details can be added. Several lines can be 

added to the magnetics table; however, only the data which is checked as Active will be used 

by the program. 

 Survey Program: This is where you create the survey program and assign the relevant error 

models to the plan. At this stage, because there is no plan yet this will remain incomplete (to 

be completed once a plan has been created). Error model can be assigned at this point by 

selecting from the drop down menu below IPM. However, if the plan is a sidetrack, then the 

details of the survey program from surface to ST depth can be entered. This will be done 

automatically when completing the Sidetrack details section. 



Doc #: IDI06-11F 
Rev: 1.6 
Issued: 10/03/20 

 

Page 15 of 40 
 

 Sidetrack Details: If plan is a ST, check the Plan is a sidetrack box and the user will be able to 

select the plan or survey that will act as the motherbore as well as determining the ST depth. 

By then selecting Create Sidetrack, the Survey program will be populated with the relevant 

details from the motherbore. 

 Tie-on: Allows the user to select where the plan is tied on. This can be from surface, a user 

defined point where the tie-on line can be manually typed in by the user or from an existing 

survey or a plan. This will be automatically populated when the Sidetrack Details section is 

completed. 

 Export Geomag Data: Exports the geomagnetics data as a document. Select the line in the 

Magnetics section that you want to export the geomagnetics data for. Then select the report 

format as PDF or Excel from the drop down menu, before selecting Export to generate the 

report. 

 Force Colour: Selecting this option and choosing a colour will ensure that this plan will 

always be displayed in this colour in all of the plots. This supersedes any colour options for 

this plan in the Chart Properties dialog. 

 Survey Tools: The Survey tool editor can be accessed from here by clicking on the Survey 

Tools button located beside the Apply button. 

 Once the required inputs have been completed, hit apply then close 

 To access the Plan Properties again at any time, right click at the Plan level and select 

properties 

The database tree should now look similar to the one below. In order to open the plan, the user 

must double click the Plan level of the database tree, and the plan window will open in the right 

hand screen. The plan can then be entered manually using MD, Inc and Azi, or the Planning Tools at 

the bottom of the screen. Once a plan has been created click Save. For more details on the Planning 

Tools, see Appendix A. 

 

 

 

 

 

 

 

 

 

 

 

Save

Double Click 
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 When you hit save for the first time, and again any time the plan is 

changed, the user is asked "Do you wish to add this plan to survey 

program". Select Yes. This will automatically update the survey program. 

 To check & edit the survey program, or assign an error model, open the Plan Properties. Left 

clicking on the Plan/survey column will reveal a drop-down menu with the available options. 

An appropriate error model can be selected, from the drop-down list in the IPM column. 

 

 

 Click Apply and then close to save this selection 

 

To view the plan listed every 30m (100ft), double click on the Planned Wellbore level of the database 

tree and it will open this in the right hand window. 
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5.1 - Show / Hide Columns 
When you have a plan selected, it is possible to choose what data you would like to be displayed by 

going to: 

 View - Show / Hide Columns 

The user can choose which columns to be displayed. It is worth noting 

that the following columns will only be displayed for a survey (not a 

plan) even though they are selected, and will only be populated if one 

of the plans is selected as Principal:  

 Distance to Plan 

 TFO+Azi 

 TFO Highside 

 TC X&TC Y. 

 Up Down & Left Right 

 Closure Azimuth - can always be displayed in a survey 

regardless of whether there is a principal plan selected. It will 

not display in a plan. 
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5.2 - Creating a Target 

The Targets properties box can be accessed from field level down by right clicking on the required 

level (Field, Facility, Well, Plan or Actual Well) and selecting Targets 

 

 

 

 

 

 

 

 

 Select Create New and the Target Properties section will become editable. 

 Target shape, size and orientation can be selected by clicking on the desired tab at the 

centre right of the screen as seen highlighted by the red box in the above image. 

 If supplied with an azimuth and a horizontal displacement, target coordinates can be 

calculated by adding these values and selecting calculate. All target centre coordinates will 

be populated. 

 Drillers target can be calculated by selecting the desired confidence level (95% is the default) 

and selecting Create Drillers Target 

o You will then be prompted to select the relevant plan before the calculation is done 

o If the planned well path does not pass through the target, the calculation will not be 

carried out 

o The size of the drillers target is affected by the Survey tool which is assigned to the 

plan - The more accurate the tool, the larger the drillers target 

 The level that a target is created on will be displayed in the filter section. A target created at 

the Field level will only be seen at that level. A target created at plan level can be seen at all 

levels.  
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 To see a target created at field level at plan level: 

o open the target properties box at plan level - you will not be able to see the target 

o Click on the Filter drop down menu and select Field 

o You will now be able to choose which levels the target will be visible on. Just check 

the required box and click Save. 
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5.3 - Adding a Lease Line or Hard Line 

Lease lines and hard lines can be created by adding a target and selecting Polygon. The lease / hard 

line coordinates can then be entered in the same way as a polygon target. Once complete, the user 

should check the “Is a Lease Line” or “Is a Hard Line” box.  

It is important to understand that once this has been checked, Well Seeker will see this as a lease 

line and not a target. The next time the user opens the target box, the lease / hard line will no longer 

be visible. To see the lease / hard lines, the user can select the “Show Lease Lines” option below the 

filter. This filter will hide the targets and display only the lease lines.  

 

NOTE, that both targets and lease / hard lines will be available to plot and can be manipulated in a 

similar way in the chart properties dialog in the plots. 
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5.4 - Adding Casing Details 
Casings can only be added at Actual Well and Plan level 

 Right click on either and select Casing, and the casing details will appear. 

 The user can now fill in the required information 

 

 

5.5 - Adding Lithology Details 
Lithology details can only be added at Actual Well and Plan level 

 Right click on either and select Lithologies, and the Lithologies box will appear. 

 The user can now fill in the required information 

 

 

 

5.6 - Adding Annotations 
Annotations can only be added at Actual Well and Plan level 

 Right click on either and select Annotations, and the Annotations details will appear. 

 The user can now fill in the required information 
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6.0 - Creating a new Actual Survey 
 Right click on the Well and select Insert new actual well 

 The Actual Wellbore Properties box will now appear 

 

 

 

 

 

 

 

 

 The initial set up of the Actual Wellbore is the same as for a plan. Refer to Creating a New 

Well Plan Section. 

 Once the required inputs have been completed, click Apply then Close 

 To access the Actual wellbore Properties again at any time, right click at the Actual Well level 

and select properties 

 

6.1 - Adding a New Survey 

 Right click on the Actual Well and select Insert new survey 

 The Survey Properties box will now appear 

 

 

 

 

 

 The user can select the appropriate Survey tool and select a tie-on 

 Once the required inputs have been completed, click Apply then Close 

 To access the Survey Properties again at any time, right click on the survey and select 

properties 
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To enter the survey and add survey stations, double click on the survey you wish to add to, and the 

survey will open in the right hand window. 

 

Once the survey has been entered, hit Save  

 A prompt will appear which asks, "Do you wish to add this survey to the survey program?". 

Select Yes. 

 Once a survey has been created and saved, the next step is to go back to the Actual 

Wellbore Properties and check the Survey program. Clicking on the Survey column will 

reveal a drop down menu with the available options. Any surveys which have been created 

below the Actual Wellbore will be available to select. Since a survey tool has already been 

assigned to each individual survey the IPM column will be automatically populated. 

 

 

 

 Click Apply and then Close to save this selection 

Once a survey has been added to the survey program, if new 

survey stations are added to the survey, on saving, Well Seeker 

will again prompt the user Do you wish to add new surveys to 

the survey program? Selecting yes will update the survey 

program Depth To column to include the latest surveys. 

6.2 - Actual Wellbore 
The Actual Wellbore is where the user can view the survey program listing. 

Double clicking on the Actual Wellbore displays an un-editable listing 

which contains all the surveys assigned to the survey program 
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7.0 – Importing a Compass Export File 

It is possible to import a Compass .xml file into Well Seeker. This file is an 

export file from Compass which contains details of plans, surveys, targets, 

error models etc. When this file is imported, all the information will be 

used to create the relevant wells within Well Seeker. 

To import a Compass .xml file, select File > Import Compass EDM File. This 

will then open a screen which will allow the user to navigate to the 

relevant file and select it. 

Once selected, Well Seeker will begin the import process. The time taken 

for this process will vary based on the size of the import. 

 

 

 

 

 

 

Import all Compass Plans: This option opens the compass import settings dialog, where the user can 

select the appropriate settings they desire when importing data from a Compass EDM file. 

 
 

 Targets and Lease Lines: Allows the user to either include or omit targets and lease lines 

when importing. 

 Coordinates: When checked, Well Seeker will use the Latitude and Longitude values 

referenced in the Compass export file for the wellhead. When unchecked, Well Seeker will 

use the Northing and Easting values.  

 Surveys Tools: When checked, Well Seeker will import any survey tools associated with the 

relevant plans and surveys. If unchecked no survey tools will be imported. Note, that if 

survey tools are not imported, and any of the imported plans and surveys reference a survey 

tool which is not available on the imported computer, then Well Seeker will use the default 

error model selected by the user. 
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 Naming Conventions: Gives the user 3 options relating to the way Well Seeker names the 

imported data in the database tree. If all boxes in this section are unchecked, the data will 

just be pulled in as it is in the Compass export file. 

o Append Operator Name to Field: Adds the relevant Operator name to the end of 

every Field name in the database. 

o Append Field Name to Facility: Adds the relevant Field name to the end of every 

Facility name in the database. 

o Append Facility Name to Well: Adds the relevant Facility name to the end of every 

Well name in the database. 

 Well Plans: This option allows the user to import ALL plans which are contained within a 

Compass Export file. If this option is not selected, then Well Seeker will only pull in the plans 

which are selected as PRINCIPAL in the export file. Default is ON. 
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8.0 - Creating a Slot Template 
At Facility level, it is possible to add a slot template. When in the Facility Properties window, select 

Templates, and the Template Editor window will pop up. 

 

 Properties: Select Create New to create a new template 

o Select Template: This will populate automatically once the Name box has been 

completed and the template has been saved. 

o Name: Add the relevant name 

o Slot Prefix: This will appear in front of all slot names. 

o Template Centre Relative to facility: This is only available when Rectangle or Circle 

is selected in Geometry. 

 Geometry: Select from Rectangle, Circle or Single Slot. Single slot allows the user to create a 

slot template that is not a predefined shape and is made up of individually entered slots. 

o Rectangle: Contains available options related to the Rectangle Geometry and will 

only be editable when the Rectangle option is selected. 

o Circle: Contains available options related to the Circle Geometry and will only be 

editable when the Circle option is selected. 

o Convert to Single Slots: This option allows the user to convert rectangle and circle 

templates into single slots. This action is not reversible once it is selected. 

 Slots: This is where the slot Name and local coordinates are input. The local coordinates are 

generated automatically for the Rectangle and Circle Geometry and are fully editable for the 

Single Slot option. 

 When a slot template has been created select apply to save 

 When more than one template has been created, the relevant template can be selected 

from the Select Template drop down menu at the top of the screen. 
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9.0 - Adding a new Coordinate Reference System (CRS) 
You may find yourself in a situation where you are required to do planning referencing a CRS which 

is not available in Well Seeker. In this situation the information relating to the CRS should be 

requested from the client and can then be used to create a new CRS in Well Seeker. 

The below screen shot is an example of the type of information which will be supplied by the client. 
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The following instructions detail how to use this information to create a new CRS. 

 Open the Geomagnetic Calculator by clicking on the icon on 

the toolbar or go Tools > Geomag Calculator. 

 Click on the "Mapping Grid" button at the top left of the box 

 Select Add CRS at the bottom left of the Mapping Grid 

 You will now have a blank template which you can start adding information to. 

 

Parameters in RED below are important and affect the output - Care should be taken to enter the 

data correctly 

 Name: This can be anything you want as it has no impact on any of the calculations. In Well 

Seeker, the naming convention is the System / and then the Map Projection, and it is 

recommended that this convention is followed. For this example, the name would therefore 

be Polska 1992 / Transverse Mercator (Gauss-Kruger) Zone 3 

 Area of use: Description of which part of the earth this CRS references and has no effect on 

any of the calculations. For this example all we know is it is in Poland. 

 Datum: This is just text and does not directly affect any calculations. For this example it is 

WGS1984. 

 System: This is just text and does not directly affect any calculations. Polska 1992 

 Ellipsoid: This is an important one and you have to choose from a drop down list of 38 

options. In this example you would choose WGS 1984 

 Semi Major Axis (m): This is the Equatorial Radius of the Ellipsoid and is automatically 

populated based on the ellipsoid selected. 

 Semi Major Axis (UOM):  This is the equatorial radius of the ellipsoid in the units of measure 

which the CRS is using and is automatically populated based on the ellipsoid selected. 

 Units of Measure: This is a drop-down menu option and you can choose from 7 options. For 

this example, it would be metre 

 1/f: This is the inverse Flattening of the Ellipsoid and is automatically populated based on 

the ellipsoid selected. 

 Map Projection: This is just text and does not directly affect any calculations - Transverse 

Mercator (Gauss-Kruger) Zone 3 
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 Projection Type: This is a drop-down menu and you can choose from 4 options – TM, 1SP 

(Standard Parallel), 2SP or STEREO 

 False Easting: 500000.00 m 

 False Northing: -5300000.00 m 

 Latitude of Origin: This should be input as a decimal - 0.0000 deg 

 Longitude of Origin: This should be input as a decimal - 19.0000 deg 

 Scale Factor: Ratio between measured distance on the map and on the ground - 0.99930 

deg 

 1st Standard Parallel: This information will be required if you select 1 SP or 2 SP from the 

Projection Type Drop down menu - Not applicable here 

 2nd Standard Parallel: This information will be required if you select 2 SP from the 

Projection Type Drop down menu - Not applicable here 

 

The Screen shot below is what your new CRS should look like based on the information detailed 

above: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Select Add CRS and your new CRS will be available to select from the mapping grid 

dropdown menu. 
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10.0 - Wall Plot Composer 
 

In addition to the individual Plan View, Section View and 3D View plots, Well Seeker also has a Wall 

Plot Composer (WPC), where different plots along with data tables can be displayed and then 

output together.  

 

As with the individual plots, the WPC option only becomes available when the user is in a plan, 

survey, planned wellbore or actual wellbore. 

The first thing to do in the WPC is to ensure that the page is setup as required. The default page 

layout will be A4 Portrait view. To change this, select File > Page Setup. The user can then choose 

sizes ranging from A0 to A7 or User Defined. 

   

The user can then start to build the wall plot by inserting the desired Charts and Tables. This can be 

done by selecting Insert from the top menu or by right clicking anywhere on the plot. 
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Certain Charts and Tables can also be inserted from the tool bar along the top of the screen. 

 

 

10.1 - Offset Selector 

The offset selector in the WPC works in the same way as it does on the main Well Seeker menu. It is 

however completely independent, which means that offset wells selected in the main menu will 

have to be reselected when in the WPC. 

When in a chart, to select an offset survey or plan, click on the 

Offset Selector. This will open the select offsets box and 

allow the user to select the relevant plan or survey. 

Once these have been selected and the dialog box has been closed, 

the user can then display the offsets on the plot by selecting the 

Offsets On / Off button.  
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10.2 - Chart Properties 

Once a plot has been inserted into the WPC, the user can then open the Chart Properties by 

selecting a chart and either using the menu, Tools > Chart Properties, or the Chart Properties icon. 

This is where most of the chart functionality is located, and allows the user to add labels, change 

colours and customise the plot. 

 

 

10.3 - Chart Zoom and Chart Scales 
Once a plot has been inserted the user can then manipulate the size of the plot and position it 

appropriately on the screen. Dragging the plot to increase or decrease its size affects the scale. Once 

the user is happy with the size of the plot and its position, they can then select the appropriate scale 

and zoom in if required. Once the scale has been fixed the physical size of the chart will also be fixed 

and the user will no longer be able to grab the corners and drag to manipulate the chart size. 

To zoom in, all the user needs to do is Left click and drag across the relevant portion 

of the plot. This will change the max and min axis values along with the scale. To Undo 

a zoom, right click on the plot and select Undo Zoom from the list of options, or 

alternatively press the z key. 

Any time the plot box size is changed, or the user Zooms in, the Chart Scales section in 

the Chart Properties updates to match. In the below left, the plot was zoomed to 

show the point of interest. The Chart Scales are greyed out but match the plot. The 

plot was then manipulated (below right) using the chart scales option to fine tune the output. 
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It is important to note that any selection made in the Chart Scales section will be overwritten if the 

user changes the physical size of the plot or zooms in or out. When the user goes back into the Chart 

Properties after doing either of these things, the check boxes will have been unchecked and the 

greyed-out values will represent what is currently being seen on the plot. 

10.4 - Grid Lines 

Grid Lines can be added and manipulated from the Chart 

Properties. The user can also select the distance between major 

and minor tick marks on the plot. When a chart is first opened, the 

default is Auto and the boxes are greyed out and empty. To 

manually select these values the user needs to uncheck the Auto 

box, and they will then be able to adjust the line spacing as 

required. The grid line colour can also be selected from here. 

10.5 - Saving a WPC Template 

In the File option at the top left of the WPC screen, the user can select to Save or 

Open an existing wall plot composer template. These templates are saved as .wpc files 

and allow the user to save the template they are working on and come back to it at a 

later date. 

 

10.6 - Table Text and Logo Size 

When a table is inserted into the WPC, it will be a fixed size. Like the plots, manipulating the border 

changes the size of the table. If the table has been stretched out of shape then the Reset Table 

Aspect Ratio button can be selected from the toolbar. This will keep the width of the table as the 

user set and alters the height of the table to set the table to the correct aspect 

ratio.  
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The Logo size can also be manipulated in the same way. However, the logo 

aspect ratio is reset using the Reset Logo Aspect Ratio button 

The initial logo input will be the primary logo selected at Operator 

Properties in the database tree. Once input this image can then be 

changed to any image, as long as the image is a .bmp file. Insert the logo, 

then right click on the logo and select Select Image. The user can then 

select any .bmp file for inclusion in the wall plot. 

 

 

10.7 - Screen Zoom 

It is possible to adjust the screen zoom. This option allows the user to zoom in, to look more closely 

at a particular section of the plot, or to zoom out to look at the 

whole plot. This feature can be accessed via the View menu.  

This option is also available on the quick access toolbar along 

the top of the WPC screen. 

 

 

 

 

10.8 – Plot Defaults 

It is possible to select plot defaults, which will be applied 

each time a plot is opened. These default selections are 

available on the main Well Seeker interface when a plan or 

survey is open. 

Select Plots from the toolbar along the top of the screen and 

the Chart Defaults options are available in the list. The 

selected defaults apply to the individual plots as well as the 

plots created in the WPC. 
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Appendix A – Well Planning Tools 
When viewing a plan, the well planning tools will be displayed at the bottom of the window. 

 

Selecting one of the seven planning tools displayed will activate other options to configure the 

chosen tool. Once all options have been entered, click on the calculate button to add it to the well 

plan. Below is a description of each available planning tool: 

A.1 – Adjust 
The adjust planning method is a simple tool that will draw a curve with the minimum dogleg 

required to reach the desired inclination, azimuth and distance from the current point. The 

exception to this is the INC, AZI, DLS option – In this case the planning tool will calculate the 

build/turn values required to reach the desired inclination and azimuth while keeping to the desired 

dogleg. 

MD, INC, AZI: Enter a MD, an INC and AZI in the text boxes in the parameters section.  

CL, INC, AZI: Enter a CL, an INC and AZI in the text boxes in the parameters section.  

INC, AZI, TVD: Enter an INC, an AZI and a TVD in the text boxes in the parameters section.  

INC, AZI, DLS: Enter an INC, an AZI and a DLS in the text boxes in the parameters section.  

 

A.2 - Build / Turn 
The build / turn planning method is a 3D planning tool in which consecutive surveys have a constant 

build / turn rate between them. The well path produced by this method is effectively describing a 

trajectory travelling around a cylinder. 

MD / CL: Enter an MD or CL, build rate and a turn rate and click on the “Calculate” button. 

INC: Enter a build rate and a turn rate and an INC and click on the “Calculate” button. 

AZI: Enter a build rate and a turn rate and an AZI and click on the “Calculate” button. 

TVD: Enter a build rate and a turn rate and a TVD and click on the “Calculate” button. 

 

A.3 -Dogleg Tool Face 
The dogleg tool face method is a 3D planning tool where build rates and turn rates will vary between 

survey stations depending on the dogleg and tool face setting requested. 

MD / CL: Enter an MD / CL, DLS and TFO and click on the “Calculate” button. 
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INC: Enter a DLS, TFO and an INC and click on the “Calculate” button. The trajectory will be 

calculated until the required INC is reached. If the INC selected cannot be reached, an error will be 

displayed. 

AZI: Enter a DLS, TFO and an AZI and click on the “Calculate” button. The trajectory will be calculated 

until the required AZI is reached. If the required AZI cannot be reached, an error will be displayed. 

TVD: Enter a DLS, TFO and a TVD and click on the “Calculate” button. If the TVD cannot be reached, 

an error will be displayed. 

TANGENT: There are two methods available for the tangent option:  

 Tangent – HC (Hold Curve): The HC option draws a tangent section then a curve to hit the 

target 

 Tangent – CH (Curve Hold): The Curve Hold draws a curve to line up on the target then a 

tangent to hit the target 

The Curve Hold method allows a larger number of targets to be reached. A NS, EW and TVD value 

must be entered. This can be done manually or by selecting an existing target. Lastly the DLS of the 

curve must be selected. If the target cannot be reached with the parameters specified, an error will 

be displayed. Usually increasing the DLS allows the target to be reached or changing the method 

from hold curve to curve hold. 

POINT: Enter a NS, EW and TVD; this can also be done by selecting an existing target from the drop-

down menu. The well trajectory will be turned using the minimum possible dogleg to reach the 

point. This method describes a constant curve to the target. If the required point is on an existing 

plan, this can be achieved by selecting plan from the target details section, choosing the relevant 

plan from the drop-down menu and selecting the appropriate MD. This MD relates to the point on 

the offset plan and Well Seeker will automatically populate the NS, EW and TVD based on this 

selected point. 

 

A.4 – Hold 
The Hold function causes the trajectory to travel in a straight line at the current inclination & 

azimuth until at reaches the specified distance or depth: 

CL: Enter a CL (Closure Length) and click on the “Calculate” button. 

MD: Enter an MD and click on the “Calculate” button. 

TVD: Enter a TVD and click on the “Calculate” button. 

VS: Enter a Vertical Section and click on the “Calculate” button 
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A.5 – Optimum Align 
The optimum align function is a powerful tool for lining up on targets at specified inclinations and 

azimuths. It is particularly useful if multiple targets are to be hit. The trajectory produced is usually a 

3D S-shape profile, which can be defined either by specifying two curve sections and a hold or by 

using two curves. If “Curve Hold Curve” is used, the doglegs for both the curve sections must be 

specified. For a “Curve-Curve” method, only the dogleg for one of the curves must be entered. If 

“Balanced” is selected, Well Seeker PRO will attempt to create a profile using the same dogleg for 

both curves.  

When selecting a point to hit, the user can choose any available targets from the drop-down menu 

or enter the N/S, E/W and TVD values manually using the user defined option. Then select the 

appropriate optimum align parameters and required dogleg, and enter the desired inc and azi and 

click on the “Calculate” button 

If there are 2 targets and the user requires the plan to “line up” the first target with the second, the 

second target can be selected from the line up drop-down menu. Well Seeker will calculate the 

tangent inc and azi between the 2 targets and automatically enter these values into the relevant 

boxes. 

It is also possible to line up on an existing plan. When Plan is selected, the user can choose the 

relevant plan from the drop-down menu and the relevant MD on the plan that they would like to hit. 

The coordinates and TVD of the point on the plan will be automatically entered and the inc and azi 

will mirror that particular point on the well plan. 

If the optimum align method cannot reach the desired inc and azi at the target point, an error 

message will be displayed. Usually increasing the doglegs will allow the target to be reached.  

If the user has multiple targets to hit, then one way to achieve this is by selecting the “Thread” 

function in the target details section. No planning method needs to be selected to open the Thread 

targets dialog; however, the feature utilises the Optimum Align functions when generating plans. 

Targets are available to select via a drop down menu at the top of the dialog, and the planning 

method options are selected at the bottom of the dialog. 
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A.6 – 2D Planning 
The 2D well planning tools are designed to allow a well from surface to be planned with a single 

click. The 2D planning tools have multiple build /drop rates but only one horizontal plane (azimuth). 

There are two options available: S-Well and Slant Well. The S-Well profile can either be a standard S 

where the inclination is dropped back to vertical at the target, or a modified S where a specified 

inclination greater than zero is reached at the target. The slant well has a constant build up rate and 

a specified kick off point to reach the target. 

 

S-Well 

 
Figure 1: S-Well 

To use this method, the KOP must be entered (the inclination will be vertical to this point), the DLS 

of the initial build (BUR 1) and then the drop rate (BUR 2). 

 
 

The user then has two additional options to choose from, final inclination (Fin Inc) and final hold 

length (Fin Hold). The user can choose to select none, one or both of these options via the checkbox 

to the right of the corresponding cell. The final details required are the target NS, EW and TVD. 
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These can be entered manually or by selecting a target from the drop-down menu. If the target 

cannot be reached with the specified parameters, a warning message will be displayed. 

No Checkboxes selected: When the user does not select either the Final Inclination or Final Hold 

options, the drop section of the plan will stop at the selected target at an inclination of 0° (if this is 

possible). This will be referenced in the Method Column of the plan as SWELL_OPT1. 

 
 

Final Inclination Only: When the user enters only the final inclination, the drop section of the plan 

will stop at the selected target at the desired inclination (if this is possible). This will be referenced in 

the Method Column of the plan as SWELL_OPT2. 

 
 

Final Hold Only: When the user enters only the final Hold, the plan will hit the target at 0° inclination 

(if possible) and will have lined up at the given hold distance entered prior to hitting the target. In 

the below example, the plan has lined up at 0° inclination 100m MD before hitting the target. This 

will be referenced in the Method Column of the plan as SWELL_OPT3. 

 
 

Final Inclination & Hold: When the user enters both values, the plan will hit the target at the desired 

inclination (if possible) and will also include a hold section prior to hitting the target. In the below 

example, the plan has lined up at 5° inclination 100m MD before hitting the target. This will be 

referenced in the Method Column of the plan as SWELL_OPT4. 
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Slant Well 

 
Figure 2: Slant Well 

To use this method, the KOP must be entered (the inclination will be vertical to this point) and the 

DLS of the build (BUR 1). The final details required are the target NS, EW and TVD. These can be 

entered manually or by selecting a target from the drop-down menu. If the target cannot be reached 

with the specified parameters, an error message will be displayed. 

 


